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1 Preface 
EM3D is a multi-platform application designed to align, reconstruct, segment, model, and analyze 
electron microscope tomography data. EM3D is compatible with UNIX, Macintosh, Linux, and 
Windows. Each dataset consists of a series of two-dimensional transmission electron microscope 
(TEM) images recorded on a CCD camera at regular tilt intervals, for instance, ±70º at 1º 
increments; fiducial markers are visible on each image to facilitate subsequent alignment.  Dual 
axis datasets contain two series of projections taken at perpendicular angles to one another. 

EM3D is being developed in the Laboratory of Dr. U. J. McMahan (Professor of Neurobiology 
and of Structural Biology at Stanford University School of Medicine), and is funded by National 
Institute of Mental Health (MH068065). EM3D software is the joint effort between cellular and 
molecular biologists, who use it daily, and the computational biologists and engineers who 
develop it.  

EM3D 1.X was developed by Dr. David Ress, David Yip, Mira Raman and Cornelia Koch-
Stoschek in the IDL environment. EM3D 2.X is being developed by David Yip in Java/C++.  

In addition to this manual a tutorial is available for using EM3D 2.X. The tutorial is designed to 
instruct a new user in the analysis of EM tomography data using a small synthetic dataset. Details 
on acquiring the EM3D application and the Synthetic dataset can be found at 
http://em3d.stanford.edu.  

EM3D has the typical benefits and liabilities of early software releases. Nevertheless, major 
efforts are being made on many levels to make this new version of  EM3D intuitive, stable, and 
easy to use. The IDL version of EM3D has been used since 1997 with excellent results in 
discovering new structures at the 2—3 nm scale, and efforts to improve features and performance 
continue.  

This software is released expressly for Research Purposes Only. 
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2 Getting Started 
All users should read this section before running EM3D for the first time. 

2.1 An introduction to this text  

2.1.1 Main sections of text 
This text contains the following sections: 

• Getting Started - This section contains all the information necessary to download, install, 
and run EM3D.  It also contains a brief description of the steps used to analyze data from 
importation to 3D surface rendering. 

• Reference Manual - This section provides more in-depth information about each feature in 
EM3D. 

• Appendix – Contains a glossary of terms, acronym list, and a list of figures. 

Most of the images in this document are taken from the Windows version of EM3D. The detailed 
appearance of the graphical user interface varies somewhat from platform-to-platform.  

2.2 Some precautions and recommendations 

We highly recommend going through the tutorial with synthetic data before using real data. 

The size of a dataset that can be loaded is dependent on the capabilities of the computer and 
effects the speed of operation. Here are some tips for dealing with large datasets: 

• Decimate the projections as they are initially loaded 

• Reconstruct a decimated volume 

• After reconstruction, do not load the projections 

• Decimate the objects when rendering 

A three-button mouse is very useful when using EM3D. On most platforms, the mouse will work 
properly in its default mode. Alternatively, a one-button mouse can be used, substituting ctrl-click 
(option-click on Macintosh) for the middle mouse button and alt-click (command-click on 
Macintosh) for the right mouse button.  

Set display color quality to “Highest” for PC platforms; on Macintosh, set monitor colors to 
millions. A single large monitor or dual monitors are recommended to accommodate the many 
windows used with EM3D. 
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2.3 Operational features overview 

EM3D provides all the process steps necessary for working with EM tomography data. The 
starting point for these operations is the raw, unaligned EM projection images (Figure 1). Note 
that the images show random spatial offsets from one another. 

2.3.1 Import raw EM projections  
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Figure 1: Raw, unaligned EM projection images 

2.3.2 Alignment 
Calculate and remove the image-to-image offsets between individual projections using fiducial 
markers deposited on the sample or contained within the sample. After alignment, the collection 
of images now appears to tilt along a common axis. 

 

Figure 2: Aligned projections 

 

: 

… … … …  

Projections:                   72                                       75                                       77                                  78    

2.3.3 Reconstruction 
Filtered back-projection converts the aligned projections into a volumetric reconstruction of the 
data. The initial EM3D interface to the volume consists of three 2D views corresponding to 
orthogonal cut planes. 

 



 

                                 
Figure 3: Reconstruction 

2.3.4 Combination of dual axis datasets (optional) 
If two orthogonal sets of projections were collected and reconstructed they are combined in this 
step into one volume.  

2.3.5 Segmentation 
Tools are provided to semi-automatically or manually isolate individual structures based on their 
image grayscale density. This process creates volumes-of-interests (VOIs), each containing a 
logically distinct structural component (Figure 4). 

 

Figure 4: Segmentation of a synthetic synaptic vesicle 

 
(Presynaptic membrane and two filaments are already segmented.) 

2.3.6 Model generation and visualization 
A structural model, usually an isodensity surface, can be created from each volume-of-interest 
(VOI). The models can be visualized in 3D renderings, turned on or off, given different colors and 
opacities, etc. 
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Figure 5: Surface model of a synthetic synaptic vesicle (blue), presynaptic membrane 

(gray) and two filaments (yellow) 

2.4 EM3D file format and maintenance 

The EM3D file format consists of two types of data files: 

1. The State file, distinguished by its ‘.xml’ extension: <filename>.xml 

2. The Binary file, distinguished by its ‘.data’ extension: <filename>.data.  

The State file initially is a small file that contains all the information about the larger Binary file 
such as projection alignment and segmentation data.  As objects are identified (Segmented) the 
State file grows, and may eventually become larger than the Binary file that contains the 
projection and volume data. 

These two files are best kept together in named directories. For example, create a directory called 
EM to contain all EM data, e.g., /EM, and a subdirectory that corresponds to a single dataset, e.g., 
/EM/dataset. This directory, in turn, should contain a single Binary file, e.g., dataset1.data, and 
one, or more, State files, e.g., dataset1xml, dataset2.xml, dataset3.xml, etc.. The Binary file only 
needs to be saved after a tilt series is reconstructed into a volume, or if the volume is filtered, or 
decimated  

Caution: All State files contain a reference to the Binary file from which they were generated; 
so changing file names outside of EM3D may result in errors.  
Do not edit the State file by hand.  

To use raw data from the EM, images must first be imported into EM3D and converted to a pair of 
State and Binary files. Current raw data formats supported by EM3D include sets of individual 
image files or an MRC stack file. 

2.5 Downloading EM3D 

The newest release of EM3D is available for download at http://em3d.stanford.edu. Please check 
regularly the website for new releases of EM3D. 

2.6 Installing EM3D 

2.6.1 Java 
Java 1.5.x or higher is needed to run EM3D.  If an appropriate version of Java is not installed on 
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your computer, it can be downloaded at http://java.sun.com/j2se. 

Note:  EM3D will work with either the SDK or JRE installed.  The JRE is much smaller. 

If Java is not installed on your computer EM3D will NOT run. 
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2.6.2 EM3D for Windows 2000 or greater 
Double click on the Setup.exe icon 

 
Figure 6: Windows Install Wizard 

Press Next> 

 
Figure 7: Select program location 

Choose the location where you want EM3D to Install. 
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If more than one user will use EM3D on the computer select Everyone. 

Press Next > on this screen and the next screen. 

EM3D will be installed and can be run from the Window’s Start Menu. 

2.6.3 EM3D for Linux  
Uncompress the file em3d.tar.gz. 

> gunzip em3d_v2.0_linux.tar.gz 

Extract the tar file into a directory. 

> tar –xvof em3d_v2.0_linux.tar  

Change to the directory you just untarred. 

> cd em3d_v2.0i_linux 

To run EM3D type 

> ./em3d 

2.6.4 EM3D for Mac OS X 
Uncompress the file em3d.tar.gz. 

> gunzip em3d.tar.gz 

Extract the tar file into a directory. 

> tar –xvof em3d.tar  

Double click em3d.command to run or type  

>./em3d/em3d.command 
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3 EM3D Visualization window 
When starting EM3D the Visualization window opens.  

3.1 File menu 

 
Figure 8: File menu of the Visualization window 

3.1.1 Open  
Open is used to load datasets that are in the EM3D format (.xml/.data files). The Open button 
becomes grayed out after a dataset is loaded.  Restart EM3D to load or reload data. 

Note: The .xml file and the .data file need to be in the same directory. 

3.1.2 Import 
Import is used to import data that are not in the EM3D format or to combine segmented objects  
from the same data saved in different files 

Import MRC – The data can be imported from either a single MRC stack or from multiple files 
containing one projection/slice each. The data can be either a series of projections or a 
reconstructed volume.  
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Note: EM3D explicitly supports only the UCSF version of the MRC file format. If you have 
problems loading your MRC stack, convert the data stack to a series of image files and import 
these in EM3D. 

Import Image – The preferable image file format is 16bit TIFF; however, most standard image 
formats are supported. The data can be either a series of projections or a reconstructed volume.  

In order to load a Dual Axis dataset, you must check the Dual Axis menu item BEFORE selecting 
Import.  After the first dataset has been  loaded you will be prompted to select the second dataset. 

Import Segmentation – This is used to combine segmented objects from different saved datasets. 
First load the first dataset. Then Import the segmentation data from the other dataset into the 
currently loaded dataset. The second dataset can be a cored version of the first dataset or a 
differently saved version of the first dataset with other segmented objects.  

3.1.3 Export 
Export is used to export an MRC stack that can be imported into earlier versions of EM3D for 
analysis. 

Export MRC - If the projections are visible in the EM3D Visualization window then the 
unaligned projections will be written in the MRC file. If the 3D volume is visible in the EM3D 
Visualization window then the volume will be exported. 

Export aligned MRC – This menu item is available when projections are visible in the EM3D 
Visualization window. It is used to write aligned projection images in the MRC file. 

No information about segmentation will be exported into the MRC file. 

3.1.4 Save 
Save > State… writes a new State file to make a record of changes to the dataset such as 
alignment or segmentations.  Only the .xml file will be saved. 

Save > Binary and State writes new State and Binary files. It is only necessary to write a binary 
file under one of the following conditions: 

1. After first Importing data into EM3D. 

2. After Deleting Projections. 

3. After Reconstructing a volume. 

4. After a successful Dual Combine. 

NOTE: When saving files, on UNIX platforms (including Macintosh), the directory to which 
they are to be saved must already exist. 

3.1.5 Delete Projection 
Delete Projection removes an undesirable projection from the series, which can be necessary due 
to bad focus, noise, or other image problems.  
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 It is necessary to recalculate the CDF after you have finished removing projections, in order 
to readjust the grayscale to appropriately represent the data, otherwise Alignment and 
Reconstruction will be compromised. 

3.1.6 Compute CDF 
Compute CDF is used to recalculate the cumulative distribution function for the projections or 
images after a slice or projection has been removed.  If the grayscale range of the image looks 
unusual at any point try selecting Compute CDF. 

3.1.7 Load Projections 
Load Projections is used in combination with Open.  If Load Projections is checked, it means 
that both the volume and projections will be available once the dataset is loaded.  Often once the 
volume has been reconstructed there is no need to go back to the projections (they use a great deal 
of memory).  This option was added strictly to reduce the amount base memory used by the 
dataset. 

Note as long as the original dataset contained projections, they will always be available with 
any state file, simply by checking Load Projections.  In other words they are never removed 
from the binary file. 

3.1.8 Load Single Volumes 
Load Single Volumes is used in combination with Open. When loading an already combined 
dual tilt dataset, check Load Single Volumes to load the 2 single volumes A and B in addition to 
the combined volume. This is necessary when recombining the two dual tilt reconstructed 
volumes. For segmenting and rendering it is recommended not to load the single volumes for 
saving memory.  

3.1.9 Dual Axis 
Dual Axis must be checked to load both sets of projections for a dual axis dataset. 

Dual axis must be selected before importing images or MRCs . 

3.1.10 Unload from RAM 
Unload from RAM is used to remove projection or volume data from memory. This is useful 
when working with big datasets to avoid memory issues. When projections are selected in the 
Visualization window projections are unloaded from RAM and only the currently selected 
projection slice is loaded into memory. When volume is selected the volume is unloaded from 
memory and the currently selected volume slice is loaded into RAM. 

3.1.11 Load into RAM 
Load into RAM is the reverse step of “Unload from RAM”. Once projection or volume data were 
unloaded from RAM this menu item becomes available to load data back to memory. 
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3.1.12 Quit 
Quit, exits EM3D. Before quiting don’t forget to save your data. 

3.2 Visualization display 

The main graphics window is called the EM3D Visualization display.  The visualization display 
has 2 modes, Projections and Volume.  In Projections mode the tilt series of images can be 
explored (Figure 9), while in Volume mode the reconstructed volume can be visualized in as a 
series of XY slices through the volume (Figure 10, left) or in 3 orthogonal views (Figure 10, 
right.) 

 
Figure 9: EM3D Visualization Window – Projections mode 

  
Figure 10: EM3D Visualization Window – Volume mode XY view (Left) and with 

transverse views (Right) 
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3.3 The controls 

3.3.1 Dataset information 
The upper-left corner of the EM3D Visualization window displays information unique to the 
dataset such as its name, source (produced by which computer or microscope), magnification, and 
pixel size, based on the data’s header information or user-specified information.  

3.3.2 Display mode 
The EM3D Visualization display operates in two modes, Projections and Volume, controlled by 
the pair of radio buttons to the right of the Averaging slider.  

• Projections mode is used to view the individual EM projections. When projections are 
initially imported, only this mode is available. The Slice slider controls which tilt-angle 
projection is displayed. The tilt angle and cursor pixel coordinates are displayed just above the 
slider.  

• Volume mode is used to view virtual slices through a reconstructed volume.  

The following coordinate system will be used to describe the volume. The (x, y) plane 
corresponds to original zero-tilt plane of the EM images, and after alignment, the y-axis 
is the tilt axis. The z-axis is the reconstructed depth axis. 

Volume mode is available only after a volume has been reconstructed or if the initial dataset 
is a volume.  The display windows take on a different character in volume mode, showing 
three orthogonal slices through the volume, with blue crosshairs indicating the relative 
positions of the different slices within the volume. The crosshairs provide a reference for 
objects’ relative positions within the volume, and they are useful for finding edges of objects 
during segmentation. One can navigate the volume display using the left mouse button: 
clicking on the (x, y) display moves the transverse (x, z) and (z, y) displays. Similarly, clicking 
on either of the transverse displays changes the slice number of the (x, y) display as well as 
the position of the other transverse display.  

3.3.3 Image magnification 
The size of the displayed image can be controlled using the Magnification or Zoom drop list 
located at the lower left corner of the window. Zooming can be particularly useful during 
segmentation (described below).  

Note: Large zoom factors can significantly decrease the rate at which the display updates. 

3.3.4 Averaging and Rotating 
Several additional controls, which are grayed out and inactive in Projection mode, become 
available in Volume mode.  

Note: All sliders in EM3D can be controlled with the keyboard arrows. Select the slider and 
use the left arrow (←) to decrease, and right arrow (→) to increase values.  

Averaging allows the selection of adjacent volume slices to average with the current slice to form 
a smoothed slice in the (x, y) plane (for display purposes only).  
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Rotating - Virtual slices can be formed at any angle through the volume. Rotation of the volume 
is controlled by three sliders: 

• X Axis rotates about the x-axis [in the (z, y) plane] 

• Y Axis rotates about the y-axis [in the (x, z) plane] 

• Z Axis rotates about the z-axis [in the (x, y) plane 

These slice images are interpolated from the volume. To permanently rotate the volume, click on 
the Apply button.  

3.4 Image menu 

 
Figure 11: Image menu 

3.4.1 Scaling 
Scaling is used to set which part of a linear contrast range visually best suits the data, e.g., for 
better fiducial acquisition with noisy data or to better view images during segmentation. Scaling 
changes the visible gray scale range for either projections or volume slices (depending upon which 
mode is selected) based on the cumulative distribution function, which is shown as a plot versus 
gray value.  

• The Min Clip and Max Clip fields set the percentage of pixel values that will be clipped; the 
corresponding gray values are displayed as the vertical blue lines on the graph. For example, 
if Max Clip is set to .99 then all of the pixels that have gray values in the highest 1% will be 
shown in white.  If Max Clip is set to .85 then the highest 15% of the pixels will be displayed 
in white. Conversely the pixels below Min Clip will be displayed black.  Increasing both clip 
values together increases the image contrast.  

• Absolute scales each image based on the range of data values in the entire tilt series or 
volume. 

• Relative scales each image based only on the currently displayed projection or slice. Relative 
is the default mode for projections, while absolute is the default mode for volume slices.  

• The Invert button reverses the grayscale, generating a negative image that is often useful for 
segmentation. 
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Figure 12: Image Scaling 

3.4.2 Review 
Review creates a movie by scrolling through projections or slices in the EM3D Visualization X, 
Y display.  The movie’s parameters are defined in the Review control (Figure 13). 

 
Figure 13:  Review Control 

• The Start Slice and Stop Slice determine, which X, Y slices are used to generate the movie. 

• Review Start Slice and Review Stop Slice determine the range of slices that are shown on 
the screen, when Review is pressed. 

• After the movie is generated it plays in a continual loop, until Stop is pressed.  By pressing 
Bounce, you can switch from displaying the movie in a loop to playing it forward then 
backward, then forward again 

Review requires a large amount of memory, the following are suggestions for getting the best 
movie of the area you want to see.   

• Turn off Transverse slices. 

• Only add slices you want in the movie by selecting Start Slice and 
Stop Slice carefully. 

• Finally reduce the size of the EM3D Visualization window. 
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3.4.3 Show 
Show controls the display of various image properties in Volume mode: 

• Crosshairs: toggles on and off the blue crosshairs in the three volume windows.  

• Transverse: toggles off or on the (x, z) and (z, y) views. 

3.5 LF menu 

The LF menu controls the look and feel of the User Interface. Figure 14 gives an example of the 
different UI’s on a Windows XP machine with Java 1.4.2. 

   
Figure 14: Look and Feel (LF) Java, Motif, and Native on Windows XP 
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4 Alignment 
4.1 Why Align 

This is a step that is unique to Electron Microscope tomography.  In x-ray CT or  nuclear medicine 
studies the resolution is such that the hardware can accurately and repeatablely find the same 
center from projection to projection; whereas with Electron Microscopy the projections are shifted 
slightly from projection to projection.  The alignment process is a way to shift the projections into 
the correct position for reconstruction. 

In a correctly aligned set of projections, each fiducial will move smoothly in a horizontal line 
during a Review.   

4.2 Alignment controls 

From the EM3D Visualization window, select Process > Align to open the Projection Alignment 
window. 

 
Figure 15: Alignment control 

4.2.1 Select Projections set 
The Set: radio buttons are used with a dual axis dataset to choose which set of projections to align.  
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Both sets must be aligned.  It is grayed out for single axis reconstructions.  

4.2.2 Sliders 
Slider values can be adjusted by sliding the tab or by entering a specific number in the text field 
and pressing the <Enter> key on the keyboard.  

• The Fiducial Diameter slider controls the size object for which the algorithm searches. 
Larger numbers can remove small noisy areas from consideration, but excessive numbers will 
merge together closely spaced fiducials. If the size of the fiducial is known use that as the 
initial value. 

• The Twist Angle is the angle the projections are rotated around the Z axis.  If the twist angle 
is known, it should be entered and then locked. Locking is achieved by pressing the left 
mouse button over the Twist Angle Label (Figure 16). By locking the angle you reduce the 
number of iterations in the Calculate step. 

    
Figure 16: Twist angle locking 

• The Threshold slider controls the strictness with which fiducials are identified, with smaller 
numbers corresponding to stricter definition of possible fiducial markers.  Large numbers 
increase the number of possible detected fiducial positions on each projection. Typical range 
is 0.25—0.5. 

• Min Projections is used in Indexing to determine which fiducials tracked through enough 
projections to remain. 

Be careful when reducing the number of projections.  It is ideal to have several fiducials track 
across the entire volume; however, this is not always possible.  When you reduce the 
minimum number of projections a discontinuity may form, where below a given projection 
one group of fiducials is used and above that projection, a different set of fiducials is used.  
The lack of overlap could yield a poor alignment that appears to have a low Total Error.  
That is why it is always advisable to Review the projections once the alignment is complete. 

4.2.3 Buttons 

• Acquire - The acquire button finds all areas in each projection that meet the criteria of a 
fiducial.  The criteria for a fiducial are established using the sliders described above.  There is 
no correspondence between the fiducial numbers on different projections at this stage. 

• Index - Indexing establishes a relationship between the fiducials throughout the projection 
series. An example: Fiducial 8 refers to the same fiducial in projection 30 and projection 90 
after indexing.  Indexing also generates a list of fiducials as seen in Figure 17. 
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Figure 17: List of indexed fiducials sorted by Projections 

• Delete removes selected fiducials from the fiducial list. 

• Calculate does a cross correlation and returns the composite Error for each fiducial and the 
Total Error for the entire alignment. 

• Display Markers overlays yellow on possible fiducials in the EM3D Visualization window. 

• Automatic performs all steps to achieve the best alignment possible from the current step. If 
no actions have been taken Automatic does an Acquire, Index, and then iteratively does 
Calculate and Delete to minimize the error while still meeting all criteria. If an Acquire has 
been done than Automatic starts with Index. If Index has been done than a series of Calculate 
and Delete operations are done.   If you are unsatisfied with the results, select Override from 
the Edit menu, then press Acquire, followed by Automatic.  If you are still unsatisfied with 
alignment change the Acquisition/Indexing Parameter sliders, and press Acquire followed by 
Automatic. 
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4.3 Fiducial list 

 
Figure 18: Alignment after calculation 

• The Fiducial column contains a list of the unique ids associated with each fiducial. When a 
single row is highlighted that fiducial can be changed in the EM3D Visualization window. 
When the middle mouse button is pressed in the EM3D Visualization window, the fiducial 
number that is highlighted in the fiducial list will be placed at that location on the current 
projection, provided a possible fiducial exists in the vicinity.  

• The X, Y, and Z columns are an estimate of the fiducial’s location in the reconstructed 
volume. Z will not be filled in until the first calculation has been done. 

• The Projections column states on how many projections each fiducial was identified.   

• The Error column gives the composite error for each fiducial based on the calculations. 

A good alignment will often yield a Total Error of less than 1.0 pixels per 512 pixels of 
resolution. i.e. 0.5 for a 256, 1.0 for a 512, 2.0 for a 1024…. 

• All columns in the fiducial list can be sorted in ascending or descending order by pressing the 
column heading. In Figure 17 the fiducials have been sorted in descending order by 
Projections and in Figure 18 the fiducials have been sorted in ascending order based on Error. 

4.4 Adjusting Fiducials on the EM3D Visualization Window 

After Indexing it is possible to Move, Add, and Delete fiducials from individual projections using 
the mouse. 
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4.4.1 Adding or moving a fiducial on a single projection 
1. Select the fiducial to add/move in the Fiducial List.   

2. Navigate to the desired projection in the EM3D Visualization window. 

3. Click the middle mouse button on the projection where it should go. 

4. If the fiducial does not go in the right place turn on the Display Markers, and adjust 
the fiducial parameters until a small yellow region appears where you want to place 
the fiducial and press the middle mouse button. 

4.4.2 Removing a fiducial from a single projection 
Click the right mouse button next to the fiducial you want to remove. 

The right mouse button removes whichever fiducial it is closest to, regardless of which one is 
selected in the Fiducial List. 

4.5 Alignment methods 

4.5.1 Automatic steps 
These are the steps that work in an ideal situation: 

1. Turn on Display Markers. 

2. Navigate to the center slice in the EM3D Visualization window.  Adjust the 
Alignment sliders until the fiducials in the image are fully highlighted.  Scroll back 
and forth through the projections in the Visualization window to ensure that the 
parameters are good for all projections.   

3. Turn off Display Markers. 

4. Lock the Twist Angle (Optional).   

Although not locking the twist angle is more time consuming it may be more accurate. 

5. Press Automatic. 

6. Un-lock the Twist Angle.  

7. Press Calculate. 

If at any point there are any projections with too few fiducials (bad projections) change the slider 
parameters (particularly Threshold).  Press Acquire and then press Automatic to restart the 
alignment process.  You may also add fiducials on the bad projections by hand as described in 
Section 4.4. 

4.5.2 Semi-automatic steps 
These are the steps for aligning datasets with less defined fiducial markers: 
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1. Acquire – Identify potential fiducials 

2. Index – Find correspondence between the identified fiducials 

3. Calculate – The error associated with each fiducial  

4. Adjust – Add, move or delete fiducials on individual projections using the mouse. 

5. Delete – Remove fiducials from the alignment that have high error or are not present 
on a large number of projections 

6. Refine – Repeat the Calculate and Delete steps until an acceptable alignment is 
obtained. 
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5 Reconstruction 
From the main EM3D Visualization window, open the Reconstruction window by selecting 
Process > Reconstruct…. 

5.1 Understand the reason for slab reconstruction 

There are several things to consider before reconstructing the volume.  A tilt-series with projection 
dimensions of 1024x1024 pixels can yield a full size reconstructed volume with dimensions of 
1024x1024x1024 pixels.  We know the thickness of our sample is always substantially smaller 
than the width of the projections.  In order to reduce the memory and time needed to perform the 
reconstruction, we will only reconstruct a slab of the volume that contains useful data. 

Below is an example using the Synthetic dataset. 

In Figure 19 we see a series of slices through the volume. The fiducial markers that rest on the top 
and bottom of the sample are visible on slices 75 and 180 respectively; indicating the range of 
useful data.  This is additionally evident in slices 40 and 216 which only contain noise.  Thus 
reconstructing only the slices between the fiducial markers (slices 75 and 180) will greatly reduce 
the amount of time and memory used.  

 

      
Figure 19: Slices 40, 75, 110, 128, 149, 180, 216 

5.2 Reconstruction controls 

5.2.1 Defining the area of the volume to reconstruct. 
Near the top of the window are two sliders that control which slab of the entire volume will be 
reconstructed. 
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Center of Slab 
Entire Volume 

 
Figure 20:Selecting slab for reconstruction 

• Center (pixels) – This determines where the center of the reconstructed volume will be with 
respect to the entire volume. The location of the center of the reconstructed volume.  The 
default value for Center is ½ the dimension of the projections in pixels. 

• Thickness (pixels) – The final thickness of the reconstructed volume.  Defaults to ¼ the 
dimension of the projections in pixels. 

• Tilt offset – Features within the specimen volume may sometimes be tilted around the y-axis 
with respect to the zero-tilt slice.  

5.2.2 Controls of numerical aspects of the reconstruction 

 
Figure 21: Reconstruction control window 

• Interpolation mode – Controls the form of interpolation used for rotating the projections. 
Bilinear (default) is faster but less accurate than Cubic. 

• Projection mode – Controls how the image data is interpreted before reconstructed. Linear 
(default) takes the EM data at “face value,” the optically thin approximation. Log mode treats 
the EM data as optically gray, taking the logarithm of the image data before forming the back-
projections. Use linear mode for thin samples, log mode for thick samples. In Log mode, the 
Log minimum slider becomes active; adjust this value to control the contrast of the 
reconstruction. 
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• Decimate – Combines pixels to reduce size of data.  A Decimate value of 1 yields a full size 
reconstruction. Use large decimation values to perform fast reconstructions that permit 
convenient assessment of parameter settings. 

• Scaling – Controls the treatment of artifacts created by the high-pass weighting process in 
Filtered Backprojection. The default value is 10%. 

• Sharpness – Controls the blurring of the final volume.  Low values are blurrier, but less 
noisy, and high values have better resolution and more noise. In addition the Sharpness level 
corresponds to the speed at which the reconstruction progresses, with low numbers being 
faster that high numbers.  The default value of 4 is a good compromise between speed, 
resolution, and noise for most real datasets.  When doing a quick, decimated reconstruction, it 
is advisable to set Sharpness to 1, and then return it to 4 for the final reconstruction. 

5.3 Reconstruction process 

These are the steps for reconstructing a 3D volume: 

1. Define the area of interest using the center and the thickness sliders.  

Decimate the volume to preview the 3D volume. 

To calculate the center and thickness use these formulas: 

center new = center current + (decimation * (max slice + min slice) - thickness current) / 2 

thickness new  = (max slice-min slice + 1) * decimation  

2. Set Interpolation and Projection mode, Scaling, Sharpness, and Tilt Offset according 
your dataset. 

3. Hit the Reconstruct button and evaluate your reconstructed volume.   
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6 Dual axis combine 
6.1 Requirements for dual axis volumes 

It is required that both volumes must have exactly the same size and contain the fiducials 
(preferably on both sides of the sample).  

6.2 Dual Combile Controls 

Select File > Process > Dual Combine… to open the Dual Combine window.  

 
Figure 22: Dual Combine 

• Set - The Set buttons indicate which volume is being displayed in the EM3D Visualization 
window.  By toggling between the buttons you can navigate from volume A to volume B. 

• Rotate B - Rotate volume B by 90 degrees either clockwise or counter.  Choose which 
direction it rotates through the Rotate menu. 

• Index – Find for every single fiducial its location in set A and B and list the pair with its 
identification and location in each volume and the distance between them after a least squares 
fit.  

• Auto Index – Index all fiducials and remove all fiducucial pairs with a high distance. 
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• Calculate – Calculate the gross registration of the 2 volumes. 

• Delete – Remove the incorrect fiducial pairs from the list. These fiducials are not taken for 
calculating the gross registration. 

• Combine – The 2 volumes are merged. The Set: Combined radio button becomes available to 
switch to the combined volume. The Average Error: is set to the average RMS error for all 
fiducials in the list after this fine alignment. 

• File > Reset – Start over dual combine.  

 

6.3 Procedure of combining 

These are the steps for combining two dual axis volumes: 

1. Rotate Set B into same orientation as set A. 

2. Identify possible fiducial pairs. 

3. Select fiducial pairs to use in calculating combination. 

4. Calculate the alignment of the volumes. 

5. Revise the fiducial pairs to get a better gross registration of the volumes. 

6. Recalculate the registration.  

7. Combine the volumes (the fine registration is done as part of the combination step). 

 

6.3.1 Rotate set B 
The first step in combining the volumes is to get them in roughly the same orientation.  We do this 
by rotating volume B by 90 degrees.  Adjacent to the Set buttons is the Rotate B check box.  Press 
this and volume B will rotate by either 90 degrees clockwise or counter – clockwise.  You can 
choose which direction it rotates through the Rotate menu. 

6.3.2 Automatically identify possible fiducial pairs 
Once the volumes are in the same orientation, press the Auto Index button in the lower right of 
the Dual Combine window. Five columns will appear in the panel.  Each row represents a single 
fiducial with its identification and location in each volume and the distance between them after a 
least squares fit.  
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Figure 23: Auto Indexed 

6.3.3 Indexing 
If Auto Index fails or yields too few pairs, use Index.  Auto Index has an arbitrary distance 
threshold, and immediately removes all pairs with a higher distance.  By using Index, those pairs 
will not be thrown out, but you must be even more careful in ensuring that pairs are valid, see the 
next section. 

6.3.4 Select fiducial pairs to use in the combination 
We want to use as many fiducials as possible to give the most information about the 
correspondence between the volumes; however, we do not want to use areas of the volume with 
heavy stain that appear like fiducials to the algorithm.   
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Figure 24: False fiducials 

            
Figure 25: Correctly identified fiducials 

By sorting the fiducials based on their A Slice number, it is easy to identify which fiducials are on 
either the top or bottom of the volume and which are really stain within the volume.  Delete the 
incorrect fiducials. 

Anytime fiducials are deleted the Calculate button should be pressed to recalculate the gross 
registration of the 2 volumes. 
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6.3.5 Combine 
When the Combine button is pressed the 2 volumes are merged.  The algorithm uses the Distance 
information generated during the Calculate process to create a regional map for local warping, in 
order to generate the fine alignment for combined volume.  After the volumes have been 
combined, the Set: Combined radio button becomes available so you can toggle to the combined 
volume.  After Combine is pressed the Average Error: is set to the average RMS error for all 
fiducial pairs in the list after this fine alignment. 
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7 Segmentation 
Segmentation allows the user to define or ‘carve out’ volumes of interest (VOIs).  Each VOI 
should contain a distinct structural component.  Each segmented object is the basis for a surface 
model, which can be displayed and manipulated in 3D. 

In order to visualize the segmentation process, this manual will reference the synthetic dataset 
distributed with EM3D. 

7.1 Segmentation modes 

Since the natures of structures observed by EM tomography vary widely, EM3D offers an 
assortment of ways to segment each object.  All object descriptions here refer to the 2D shape in 
the (x, y) display. 

There are two classes of segmentation available in EM3D, automatic and manual.   

• Automatic segmentation requires the user to define an object on a single slice of the volume, 
then the program finds logical extensions of the object on subsequent slices. 

Below are 3 distinct sub-classes of Automatic segmentation 

o Closed – Used for objects that are topologically closed, such as the cross 

section of a sphere.  

o Isolated— Used for most ’open-ended’ objects.  The drawback to Isolated 

segmentation is that the algorithm used for propagating an Isolated object 

often contracts the anchor line as it propagates. 

o Pinned – Used for ‘open-ended’ objects that have endpoints that occur in 

the same X, Y position in each slice, such as a cell membrane that stretches 

from one edge of the volume to another edge. 

• Manual segmentation is required for any object that is too complex for the automatic 
segmentation to follow, so the user must define the object on each slice.   

7.2 Segmentation procedures 

In this section we will outline the basic procedures for segmenting objects, using the synthetic 
dataset as an example. (Most of this information was taken from the EM3D Tutorial) 
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7.2.1 Automatic closed segmentation   
The four spherical membranes are designed to simulate synaptic vesicles.  Closed segmentation is 
the appropriate method to use for these objects because they can be fit by a closed polygon and do 
not vary substantially from slice to slice. 

Open the Segmentation window by selecting Process > Segment… from the EM3D 
Visualization window. 

 

 
Figure 26:  Segmentation Window 

7.2.2 Segmenting the upper right vesicle 

Select New Object from the File menu. 

 
Figure 27:  Segmentation File Menu 

 
1. A default object name appears, such as Object 1, in the name field.   The name 

should be replaced with a more descriptive name, in this case, Vesicle 1. 

Note: All new segmentations default to the Automatic, Closed type. 
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Figure 28:  Initial segmentation anchor 

1. Use Zoom on the EM3D Visualization window to magnify the image by 250%.  
Then center the upper right vesicle in the X, Y display using the sliders. 

2. Using the middle mouse button, select several points in the membrane of the vesicle 
to create a rough anchor path for the vesicle (Figure 29a). Poorly placed points can 
be removed by pressing the right mouse button. 

All segmentations of the same object will vary slightly, due to the selection of the 
anchor points. 

3. Press Search (Figure 29b).  Notice that the area around the yellow anchor line fills 
with red, and the Minimum gray value and Maximum gray value sliders in the 
Segmentation window adjust. 

4. Reduce the Maximum gray value slider to a value that defines the stain only 
(Figure 29c) and press Segment (Figure 29d). 

Note:  All numbers are rough guides, since segmentations will vary based on anchor 
points. 
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Figure 29: a) Outlined, b) searched area, c)  reduced Maximum Gray value, and d) 

Segmented center slice of Vesicle 1. 

4. Press Propagate to segment the remaining slices in the vesicle. 

5. Press the Home button to return the Zoom to 100%, in order to see the segmentation 
in all 3 windows. 

6. Left click inside the segmented vesicle in order to center that vesicle in the 
transverse displays. 

 
Figure 30: Initial propagated segmentation of vesicle 1 

7. From the 2 transverse views we see that the propagation worked well for most of the 
vesicle, but needs some adjustment at the top and bottom slices. (Figure 31).  Adjust 
the propagated segmentation to correct this problem. Use the navigation controls in 
the Visualization window to find the slice where the vesicle ends, which should be 
around slice 87. Now, press the Set Stop button on the Segmentation control 
window. 

Note:  Your propagation may not look the same depending on the initial points 
chosen. 
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Figure 31: Propagated segmentation with artifact-induced error (left) and after 

adjustment (right).  

8. Finally, adjust the Surface width slider until the entire structural component is 
enclosed (approximately 15). If possible, the surface width should always be set 
generously so that the entire object is enclosed by the VOI. This permits accurate 
generation of surface models, discussed in the next Section. 

7.3 Automatic isolated segmentation 

This is used for objects such as membranes and filaments.  
For example, segment the synthetic, rod-like filament connecting the lower left to the upper right 
vesicle.   

1. In the Segmentation window, select File > New object. 

2. Name the object. 

3. Select the Isolated radio button. 

4. Navigate to center of the object in the EM3D Visualization Window. 

5. Zoom into the image by 250%. 

6. Place several anchor points along the rod, using the middle mouse button (Figure 
32a). 

    
Figure 32: Isolated anchor: a) anchor line. b) searched. c)maximum grey reduced. d) 

Segmented. 

 

 
7. Leave the Surface width and smoothing sliders at their default values:  

8. Press the Search button (Figure 32b). 
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9. Reduce the Maximum gray value (Figure 32c). 

10. Press the Segment button (Figure 32d).  

11. Press the Propagate button.  

 
Figure 33: Propagated isolated filament. 

12. Examine the segmentation in the EM3D Visualization Window.   

13. If you are unsatisfied with the segmentation try the following techniques 

• Adjust the start / stop slice for the propagation and re-propagate. 

• Adjust individual segmentation lines by pressing the middle mouse button over 
the segmented filament. 

The following message will appear  

 

Select Yes.   

The yellow anchor line will reappear for the object.  Adjust the anchor line and press 
Segment. 

Repeat for all slices that need adjusting, either individually or through re-propagation. 
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7.4 Automatic pinned segmentation 

The endpoints of a pinned object occur in same x, y position throughout all the slices.  This type of 

segmentation works well for objects like the membrane in our synthetic dataset. 
1. In the Segmentation Window select File > New Object. 

2. Name the object. 

3. Select Pinned segmentation. 

4. Use the middle mouse button to select points for the anchor, and the right mouse 
button to remove points from the anchor line. 

5. Press Search. 

6. Reduce the Maximum gray value. 

7. Press Segment. 

8. Press Propagate. 

 
Figure 34: Propagated pinned segmentation 

7.5 Strategies for adjusting automatic segmentations 

7.5.1 Setting the start/stop slice 
If the segmentation propagates beyond the edge of the object, then use the Start Slice and Stop 
Slice sliders to identify the range of the object.   
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7.5.2 Adjust minimum/maximum gray value 
Usually it is a good idea to reduce the Maximum gray value to only include values that 
correspond to the stained object.  This helps the algorithm follow the line of interest and not get 
attracted to noise. 

7.5.3 Smoothing 
The smoothing slider determines how fast the curve can deviate.  By increasing the smoothing 
value, you can reduce the likelihood of wild fluctuations in the anchor line.  Conversely if you 
have a shape that is changing rapidly, you will need to reduce the smoothing to allow the anchor 
line more flexibility. 

7.5.4  Adjusting the anchor line and re-propagating 
Often a segmentation will propagate smoothly for many slices, but then begin to deviate, 
especially with convoluted membranes.  A good way to approach such a situation is to allow the 
object to propagate.   

1. Scroll through the slices to where the segmentation begins to deviate.   

2. Right click the mouse button to move into adjust mode. 

3. Adjust the anchor line. 

4. Press Segment. 

5. Depending on direction you want to propagate set the Start or Stop slice to the 
current value. 

6. Press Propagate. 

Example:  Initial Reference slice is 50.  The segmentation starts to go awry at 60.  Adjust the 
segmentation on slice 60 and set the Start Slice to 60. Press Propagate. 

Note:  Uncheck the Adjust Mode button before rendering the object. 

7.5.5 Using a thinner search width 
When objects with similar grayscale are adjacent it is often a good idea to use a smaller search 
width when propagating the segmentation.  This will help the algorithm stay in the desired object.   

After the propagation is complete be sure to increase the width to include the entire object. 

7.6 Manual segmentation 

When structural components have a complex topology or are too noisy for automatic segmentation, it 

is necessary to perform a manual segmentation. In manual segmentation, the goal is to literally define 

the boundaries of a VOI that encloses the structural component. In the following section a manual 

segmentation will be performed for the small filament that connects the two vesicles on the right-hand 
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side of the reconstructed Synthetic volume. 
1. File > New Object. 

2. Select the Manual tab.  

3. Name the object.  

4. In the EM3D Visualization window navigate to slice 70. 

5. Zoom and center the object in the window. 

6. This time instead of drawing an anchor line in the center of the object we are going 
to draw a closed path around the object. 

Be sure to include the entire object inside the path, because only points inside the 
outline will be considered. 

7. Use the middle mouse button to define anchor points, creating a closed path around 
the object. Only a few points are necessary. The path can be defined using either the 
Spline or Piecewise interpolation-mode radio buttons. Spline interpolation connects 
the anchor points with smooth curves (Figure 35a); piecewise interpolation connects 
them with straight lines.  

   
Figure 35: a) Outline for manual segmentation. b) Segmented region. 

8. Press the Segment button. The interior of the volume is now marked with a red 
overlay and the anchor path turns green (Figure 35). All points in the interior on this 
slice have now been added to the VOI for this object. 

9. Press the Up button to move to the next slice. The same anchor points that were 
defined on the previous slice appear and can be edited using the mouse with middle 
button to add, and right button to delete points. 

10. When satisfied with the anchor path, press the Up button again. 

Pressing the Up or Down button is equivalent to pressing the Segment button and moving the 
slider one slice. 

11. At the topmost slice containing the object, select Segment.  
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12. Return to the 1st slice segmented using the Visualization Window Navigation Tools; 
NOT the Down button.  

13. Navigate down one slice, using the Visualization Window Navigation Tools; NOT 
the Down button.  From here repeat steps 7 and 8 using the Down button to segment 
the lower half of the object. 

14. Continue editing points as necessary (little editing will be necessary for this simple 
object) and pressing the Down button until the lowest slice containing the object is 
reached; select Segment again. This completes the manual segmentation of this 
object. 

7.7 The Segmentation and Object Control Panel 

The first thing to realize about this panel is that it controls BOTH the generation of Objects, and how 

those Objects are displayed in the EM3D Visualization Window. 

7.7.1 Objects Menu 

 
Figure 36: Segmentation Object Menu 

• New Object – Generates an object. 

• Re-anchor – After an object has been segmented and propagated you may want to adjust the 
anchor line, this can be done by either selecting Re-anchor or pressing the middle mouse 
button in the EM3D Visualization Window. 

• Clear Object – Removes all segmentation that has been done in the object, as well as its 
name.  The object still exists, it is just empty. This roughly equivalent to the combination of 
Delete Object, followed by New Object; however, it holds its place in the Object List. 

• Delete Object – Completely removes the object from the Object List.  

• Clear Slice – Removes any anchor or segmentation on the current slice. 

• Set SNR Reference – not currently used. 

7.7.2 Objects List 
The Objects List is used to control which objects are overlaid on the volume in the EM3D 
Visualization Window.  In order to segment or adjust segmentation, an object must first be 
selected in the Objects List. 
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Figure 37: Object List 

An object name is written in green if it is displayed in the EM3D Visualization Window. 

An object name is red if it is hidden. 

If an isosurface has been created for an object, the isosurface will be shown in the EM3D 
Visualization Window when it is Enabled.  It can still be adjusted by clicking the middle 
mouse button inside the EM3D Visualization Window.  This will delete the isosurface and 
allow segmentation adjustment as normal. 

The highlighted object is available for segmentation or segmentation adjustment. 

Multiple objects can be selected for display purposes, but only one can be segmented at a time. 

• The button in Figure 37 that says Disable is a toggle button and will change its text to Enable 
depending on whether the first highlighted object is Enabled or Disabled.   

• The Line check box is used to display the anchor lines of all the objects. 

• Volume Width is not currently used. 

7.7.3 Automatic Controls 

    
Figure 38: Automatic segmentation controls 
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• Closed, Isolated, and Pinned radio buttons are used to select which type of Automatic 
segmentation is to be preformed. 

The Set Start, Reference Slice, and Stop Slice buttons are used to interact with the EM3D 
Visualization Window. 

• Set Start sets the Start slice slider to the current slice in the EM3D Visualization Window.   

If the object has already been segmented and the new start slice is higher than the current start 
slice a question similar to Figure 39 will appear. 

If the Adjust button is selected this new start value will be used as the start for the new 
Propagation region and anything below this value will remain unchanged. 

                                               
Figure 39: Adjust Start 

• Reference Slice moves the EM3D Visualization Window slice to the Reference slice. 

• Set Stop sets the Stop slice slider to the current slice in the EM3D Visualization Window.   

If the object has already been segmented and the new stop slice is lower than the current stop 
slice, a message similar to Figure 39 will appear. 

If the Adjust button is selected this new stop value will be where future Propagations will 
end; leaving the slices above it un-altered. 

The Search, Propagate, and Segment buttons: 

• The Search button finds the grayscale range in the area defined by the anchor line and the 
Surface width.  It then adjusts the Minimum and Maximum gray value sliders accordingly. 

• The Segment Button creates the segmentation on the current slice based on the Minimum 
gray value, Maximum gray value, Surface width, and the Smoothing slider values.  The 
anchor line will change from the original hand selected points to a smooth green line that was 
fit to the grayscale image. 

• The Propagate button uses the parameters defined by the Surface width, Smoothing, 
Maximum gray value, and Minimum gray value to define the object on slices between the 
Start slice and Stop slice.  It stops “propagating” when no values meet the criteria.  After the 
object has been propagated the start and stop slice slider values are set to the limits found 
during propagation.   

• Multiple propagations can be done on the same object by defining a new anchor line, or 
adjusting an old one. Simply click the middle mouse button on the slice you want to be the 
new reference, define the anchor, and adjust the Start and Stop slice sliders. Press Search; 
adjust the Minimum/Maximum Gray. Press Segment. Press Propagate. 
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The Sliders: 

• The Surface Width slider determines the outer boundaries of the object.  Although it is only 
shown in 2D on the image, it is applied in 3D to the object when an isosurface is generated.  It 
is often useful to make the Surface width low during the Segmentation and Propagation 
phases, then increase it to cover the entire volume for the isosurface generation phase. 

• The Smoothing slider determines how fast the anchor line can vary.  It is often necessary to 
have a high smoothing value with noisy data, to prevent the anchor line from wildly drifting. 

• The Start slice slider sets the lower slice in the propagation range. 

• The Stop slice slider sets the upper slice in the propagation range. 

• The Minimum gray value and Maximum gray value slider determine which voxels in the 
volume are considered part of the object for segmentation purposes.  Because the Search 
button sets these values to the extremes within the search region, it is often necessary to adjust 
these values so that only the stain is highlighted in red in the EM3D Visualization Window. 

• The Adjust Mode button is turned on anytime a Segmentation is altered.  When selected it 
affects how the Start and Stop slice sliders work. See Set Start, Reference Slice, and Stop 
Slice above. 

7.7.4 Manual Controls 

                            
Figure 40: Manual Segmentation Control 

• The Spline method connects the anchor points with curved lines which are influenced by 
multiple neighbors; whereas, the Piecewise method draws straight lines between points. 
Figure 41 shows the exact same points with Spline and Piecewise connectivity. 
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Figure 41: Spline connectivity (right) and Piecewise (left) 

• The Segment button fills the entire area within the anchor with red overlay and adds the 
pixels to the segmentation region. 

• The Up button is equivalent to pressing the Segment button on the current slice, then moving 
the EM3D Visualization Window to the next slice up, and copying the anchor line from the 
previous slice. 

• The Down button is equivalent to pressing the Segment button on the current slice, then 
moving the EM3D Visualization Window to the next slice down, and copying the anchor 
line from the previous slice. 

• The Clear button removes the anchor line (and the segmentation) from the current slice.  It 
does not clear the entire object.  In order to clear the entire object, select Clear Object from 
the Objects menu. 
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8 Model generation and 3D visualization 
controls 
All features for 3D model generation and visualization are accessed from the EM3D Render 
window, which is opened by selecting Process > Render in the EM3D Visualization window.  
The Render window contains three parts, the Render menu, the Render controls, and the 
Render display.  The Render controls allows you to select which objects are Enabled and the 
characteristics used to display them in  the Render display.  The Render Menu controls both the 
global appearance of the Render display, and provides some additional interaction with the 
objects and the original image volume. The Render display is the window where the 3D objects 
are displayed. 

 
Figure 42: Render Window 
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8.1 Object rendering states 

An object can be either Enabled or Disabled.  When an object is Enabled, the isosurface is calculated 

using the region of the volume that was selected during Segmentation and the Isosurface Level 

selected in the Main tab of the Render controls.  Enabled objects can be Shown or Hidden.  The 

difference between Hide and Disable is subtle, but using the right one can save you a lot of time.  If 

you are happy with your isosurface level, but do not want to see a particular object you can Hide it by 

highlighting it and selecting Surface > Hide from the Render menu.  By doing this, the isosurface is 

preserved; the object is just not drawn in the Render display.  If you press Disable, the isosurface will 

be deleted and a new isosurface will be calculated. 

8.2 The Render controls 

8.2.1 Object tab 
This tab contains a full list of all of the objects that have been segmented.  Objects can be shown 
in 

Green – Enabled and currently visible in the Render display 

Red – Disabled but available for Enabling. 

Blue – Hidden, so the isosurface exists, but it is not visible in the Render display 

Black – Something is wrong with the Segmentation, and it is not available for Enabling, check the 

Segmentation. 
Multiple Objects can be selected and whatever action is performed will apply to all objects that are 
selected. Use Select All from the Objects menu to select all objects in the list. 

Double click on an object to rename the object. 

8.2.2 Group tab 
This tab contains a full list of all of the groups that have been created.  A group is a selection of 
objects arranged together. See Objects menu on how to create a group. Objects can be shown in 

Multiple Groups can be selected and whatever action is performed will apply to all objects that are 
selected. Use Select All from the Objects menu to select all groups in the list. 

Double click on a group in the list to rename the group. 
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8.2.3 Main control tab 

 
Figure 43: Render controls - Main tab 

• Isosurface level - An isosurface is created by connecting points in the volume that have the 
same grayscale value.  The surface that is generated does not have to be connected. 

Each level corresponds to 0.1% of the grayscale range of the segmented object.   

emnGrayScalemxGrayScalangegrayScaleR −=  

( ) anglegrayScaleRemnGrayValugrayValuelevel /*001.0 −=  
• Edge Preservation 

• Position, Volume and Area 

The Position value gives the centroid of the surface points for the selected object(s). 

Surface area is the total area of all triangles used to create the 3D surface model, and is 
highly dependent on the isosurface level chosen. 
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Figure 44: Surface area and Volume range based on isosurface level 

Isosurface 

level 

650 675 700 

Surface 

Area 

(nm^2) 

24366 35514 27394 

Volume 

(nm^3) 

21624 59583 96236 

 

Please remember that the surface area (SA)  and Volume (V) are based on  the triangles of 
the object model. This usually results in SA’s more than twice the exterior surface area of the 
object, and volumes far less than the volume of the membrane. 
 
Example:  Spherical Vesicle in Figure 44 with outer radius of 32nm and inner radius of 
21nm.   
Outer SA: 4 * π ∗ r2 = 4 * π * 322=12868nm2

Inner SA: 4 * π * 212 = 5542nm2

Total SA: 12868+5542 = 18410nm2

Outer Volume: 4 * π / 3 * r3 = 4* π /3 * 32^3 =137258nm3

Inner Volume: 4* π /3 * 213 =38792nm3

Total Volume: 38792-137248 = 98466nm3

Isosurface 

level 

650 675 700 

Surface 

Area % 

calculated 

1.32 1.93 1.49 

Volume 

% 

.21 .61 .98 
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calculated 

 

• Surface Decimation combines vertices for rendering the selected surface model to reduce 
data. Use a high decimation for speeding up the enabling of a surface model. 

8.2.4 Color control tab 
EM3D uses an RGB color model.  Figure 45 represents how red, green, and blue blend together to 
form other colors.  Each color has an intensity range from 0-255.  Figure 45 represents the 6 sides 
of a cube created with blue, red, and green as the axes.  In each of the 3 surfaces shown on the left, 
one color is set to 255.  For instance on the top surface green is set to 255 and contributes its 
maximum intensity to all colors blended on that surface, while in the image on the right there is no 
green contribution to the bottom surface.  

      

Figure 45: RGB color volume 

As you move the sliders in the Color tab, the New: color swatch will immediately change.  If 
Auto Apply is selected then the object in the Rendering window will also change color. 

Note:  The color change may lag in the Rendering window if Auto Apply is selected with large 
datasets. 
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Figure 46:Color Tab 

 

8.2.5 Material tab 

 
Figure 47: Material tab 

• The Opacity slider controls the transparency of the object(s).  If it is set to 255 it is 
completely opaque and if it is set to 0 it is invisible.   

                              
Figure 48: Vesicle opacity of 0, 25, 50, 100, and 255 
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• The Gloss slider controls how reflective the surface is. 

     
Figure 49: Gloss of 0, 50, and 100 

8.2.6 Thickness, Proximity and Uncertainty tab 
For a detailed description of the Thickness, Proximity and Uncertainty control tab see 
Calculations. 

8.3 Objects menu 

• The Select All menu selects all objects in the objects list. When the group tab is open all 
groups are selected. 

• Group arranges selected objects together to a group. First select objects for grouping. Second 
go to Group in the Objects menu and type in a name for the group.  

• Auto 2D Enable – Check that box to mark the object in the 2D Visualization window when 
objects get enabled in the Rendering window. 

• Delete erases the selected group from the group list.  

• Combine – not implemented yet. 

• Export Object – not implemented yet. 

8.4 Effects menu 

8.4.1 Anti-Alias 
Anti Alias - Display the models at 4 levels of alias reduction: 2x, 4x, 8x, 16x or with out reduction 
(off). 
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8.4.2 Lighting 

 
Figure 50: Lighting control 

• Ambient lighting is the most general kind of lighting.  It is the background light, Think of 
ambient light as having no direction and no source (technically not true, but a good way to 
visualize it).  By adjusting the color and intensity of the ambient lighting you can change the 
general appearance of the rendering.  Because ambient lighting refers to all background light 
there is no need for multiple ambient lights. 

• Directional lighting is the second most generic form of lighting we will use.  Think of a plane 
or sheet source of light with all the rays pointing parallel to the vector from the X, Y, Z 
position towards the center of the volume.  You can control the color, intensity, and direction 
of a Directional light. 

• Positional lighting is a cone beam of light beginning at a specified point.  This is our spot 
light.  For a positional light you can pick its, color, intensity, origin (position), cone angle 
spread, and the direction it points. Additionally, if Local Lights is checked then Positional 
lights move with the Rendering, continuing to spot light the areas at which they were 
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originally targeted.  If Local lights is unchecked, the region of space that is illuminated does 
not change, similar to a street light on a freeway, it lights up whatever car goes underneath it. 

 

8.4.3 Clip Panes 
The Clip Planes window controls a maximum of 6 clipping planes. A Clip Planes cuts away the 
portion of the models on one side of the plane. 

                                     
Figure 51: ClipPlanes control and example 

• Clip Planes list – 6 different cut planes can be selected.  

• Position - X, Y, Z sliders define the position of the selected clipping plane in the volume.   

• Direction - The Theta slider defines the rotation angle about the z axis, and the Phi slider 
defines the rotation angle about the x axis. 

• Enable - The Enable button initiates clipping for the currently selected plane in the Rendering 
window. The label of the button changes to Disable. Press the button to unclip the models 
along the plane in the Rendering window. 

• Apply - It applies changes of the clip planes settings (Position and Direction) in the 
Rendering window. Check the Auto Apply check box to automatically apply any change in 
the settings of enabled clip planes. 

• Defaults -  Disables all clip planes and sets Position and Direction to default settings. 
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8.4.4 Cut Planes 

                  
Figure 52: Cut Planes Control and example of XY Slice Cut Plane enabled  

The Cut Planes window controls the display of up to 3 principal-axis cut planes overlaid on the 
3Dmodel rendering. 

• Opacity controls the opacity/light resistance of the planes within the 3D rendering.  

• The XY, XZ, and ZY Slice sliders specify the cut plane slice displayed in the corresponding 
axis. 

• Enable/Disable enables or disables the corresponding cut plane. 
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9 Calculations 
Thickness, Uncertainty and Proximity are available calculations. The controls for these 
calculations are accessed from the tabbed controls panels located at the middle of the Rendering 
Window. Surface models must be created (see Object rendering states) before initiating any of 
these calculations. 

 

Figure 53: Thickness, Proximity and Uncertainty control tabs 

9.1 Thickness 

The Thickness tab controls thickness calculation of the selected surface model objects.  

• The Calculate button initiates the thickness calculation. Select one-or-more objects in the 
object list for which the thickness should be calculated. 

• The plot window displays a histogram of the frequency of vertices  per measured thickness. 
Move the cursor to the graph or color bar to show the exact thickness at the current point. 

• The Min and Max sliders eliminate vertices smaller and greater the minimum/maximum 
thickness value  (outliers) and recalculate statistics. 

• The min, max, med, mean and bad fields located under the histogram, display, respectively, 
the minimum value, maximum value, median value, mean value and percentage of bad values 
for the thickness data. 

• The Overlay checkbox controls the display of the thickness data as color map overlaid upon 
the associated surface model.  

                                   
Figure 54: Histogram of vesicle thickness and colored overlay in vesicle  
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9.2 Proximity 

The Proximity tab in the Rendering Window controls proximity calculations among the currently 
enabled objects. These calculations require that one object be designated as a reference, while one-
or-more models be designated as destinations. Proximity values are distances between each 
destination vertex and its nearest vertex on the reference object surface. 

• Set Reference button sets the selected object from the object list as reference.  

• Calculate initiates the calculation of the proximity. One-or-more objects have to be selected 
for which the proximity to the reference surface model will be calculated. 

• The plot window displays a histogram of the frequency of voxels  per measured distance to 
the reference object. Move the cursor to the graph or color bar to show the exact distance at 
the current point. 

• The Min and Max sliders eliminate voxels smaller and greater the thickness value in the 
fields (outliers) and recalculate statistics and overlay. 

• The min, max, med, mean and bad fields located under the histogram, display, respectively, 
the minimum value, maximum value, median value, mean value and percentage of bad values 
for the proximity data. 

• The Overlay checkbox controls the display of the proximity data as color map overlaid upon 
the associated surface model.  

                                    
Figure 55: Proximity histogram of filament1 and filament2 and visualization in Rendering 

window 

9.3 Uncertainty 

The Uncertainty tab in the Rendering Window controls the spatial uncertainty calculation, a 
measure of the reliability of an isosurface model. Before calculating the uncertainty it is required 
to manually segment an area of noise as a reference object.  
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Figure 56: Manually segmented signal-to-noise ration and special uncertainty histogram 

• The Set Reference button sets the selected object as the SNR reference.  

• Calculate initiates the calculation of the uncertainty. One-or-more objects have to be selected 
for which the uncertainty will be calculated. 

• The plot window displays a histogram that combines all of the special uncertainty result from 
the currently selected models. 

• The Min and Max sliders eliminate voxels smaller and greater the value in the Min/Max field 
(outliers) and recalculate statistics and overlay. 

• The min, max, med, mean and bad fields located under the histogram, display, respectively, 
the minimum value, maximum value, median value, mean value and percentage of bad values 
for the combined calculated data ensemble. 

• The Overlay checkbox controls the display of the thickness data as color map overlaid upon 
the associated surface model.  

 

EM3D Manual 

 63

 



 

10 Appendix  
10.1 Acknowledgments 

 
We would like to acknowledge the following groups whose code is either used in this program or 
has provided inspiration: 

• Paul Bourke  

Algorithm from "Polygonising a scalar field" by Paul Bourke 
http://astronomy.swin.edu.au/~pbourke/modelling/polygonise 

• Takuya Ooura  

"General Purpose FFT (Fast Fourier/Cosine/Sine Transform) Package"  

http://momonga.t.u-tokyo.ac.jp/~ooura/fft.html 

• Lee Thomason and Yves Berquin  

"TinyXml"  

http://sourceforge.net/projects/tinyxml

• LAPACK  

Linear Algebra PACKage 

http://www.netlib.org/lapack

•  Fautré , Tanguy  

Tri Stripper 

http://users.pandora.be/tfautre/softdev/tristripper/

• Ken Martin, Will Schroeder, and Bill Lorensen  

vtkThinPlateSplineTransfrom algorithm from "VTK"  

http://public.kitware.com/VTK

Copyright (c) 1993-2002 Ken Martin, Will Schroeder, Bill Lorensen  

All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
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CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED 
WARRANTIES,INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
AREDISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) 

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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10.2 Glossary 

CCD: A device made up of semiconductors arranged in such a way that the electric charge output 
of one semiconductor charges an adjacent one.  Used to acquire images like a camera. 

Cumulative Distribution Function: The probability that an image value is less than or equal to 
the current value, given the sum (numerical integral) of the image histogram f(i): 

F(x) = f (i)
i= 0

x

∑
 

Decimation: The image or volume size reduction expressed as a log2 exponent, so a decimation of 
0 means no decimation, full resolution. A decimation of 1 is 1/2, decimation of 2 is 1 / 22 or 1/4, 
decimation of 3 is 1 / 23 or 1/8, etc. 

Fiducial Markers: also referred to as fiducials, colloidal gold beads placed on the surface of the 
TEM sample or incorporated into the sample used to align the projections. 

Intersection: Equivalent to Logical AND, meaning that a point is not added to the new region 
unless all selected VOI’s exist at that point 

Invert: Invert the grayscale of an image to create a negative image. 

Isosurface/isodensity: A region or surface in which the image grayscale is the same, similar to 
topographic lines on a map. 

Projections: Electron micrographs of the individual tilts in the dataset used to reconstruct a 3D 
volume. 

Radio Buttons:  A group of buttons in which exactly one button is selected at a time. 

Signal-to-Noise Ratio:  The ratio between ‘signal’, the desired quantity measured by an image, to 
the ‘noise,’ the random variations in that quantity. In EM tomography, the signal is usually the 
contrast between a structural component and its adjacent background, while the noise is a complex 
function of the EM projection image formation and subsequent tomographic processing steps, so 
SNR is usually estimated empirically from the standard deviation of a relatively uniform 
background portion of the reconstructed volume. 

Slices: These are the 2D images that are virtually sliced (interpolated) from the reconstructed 
volume. 

Tessellation: Creation of small triangles that represent a surface and can be used in surface 
rendering. 

Transverse: The 2 orthogonal views to the x,y plane – the (x,z) and (z, y) planes. 

Topology: Properties of geometric figures or solids that are not changed by stretching or bending.  
Donuts and picture frames have equivalent topologies. 

Twist Angle:  The rotation of the projection tilt axis about the depth axis 
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Union:  The logical OR of two or more objects, i.e. considered true if any object lies in the space 

Vertex: A point in 3D space that defines a corner of one or more polygons. 

Volume of interest: A subset of the volume containing defined by the user or an object. 

Voxel: Short for volume element, the smallest distinguishable cube in a three-dimensional image. 

10.3 Acronyms 

CCD: Charged-Coupled Device 

EM: Electron Microscope 

MIP: Maximum Intensity Projection 

MPEG: Moving Pictures Experts Group, digital video format 

MRC stack: output dataset from the microscope 

nm: nanometer 1x10-9m 

RMS: root mean square  

SNR: signal to noise ratio 

TEM: Transmission Electron Microscope 

TIFF: Tagged Image File Format 

VOI: Volume of Interest 
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